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Contents 
•••••• 

Communications regulation information v1 

Important safety instructions v11 

1 Getting Started With the QuickTake 200 Camera 1 
Do you have what you need? 2 

System requirements 2 

Your camera at a glance 3 

The camera mode dial 4 

Insta ll ing the QuickTake software S 

Insta lling the batteries 6 

Replacing the batteries 7 

Installing the storage card 7 

Formatting the storage card 9 

Write-protecting the storage card 9 

Attaching the carrying strap 10 

Setting the date a nd ti me in the camera ll 

Displaying and hiding the date and time 12 

What if you upgrade your syste m software? 12 

W hat's next? 12 

iii 



iv Contents 

2 Using the Camera to Take Pictures 13 
Turning on the camera 13 

Taking pictures 14 

Frame numbers 15 

Setting the focus 16 

Selecting the aperture 17 

Adjusting the LCD screen brightness 17 

Using the optical viewfinder 18 

Using the camera mode dial 19 

Record-Fine and Record modes for taking pictures 19 

Self-Timer mode 21 

Play mode for the camera and the television 21 

Auto-Play mode 23 

Computer mode 23 

Erase mode 24 

Protect mode 25 

Battery-saving mode 26 

Auto-power-off function 27 

Using the camera with the optional AC power adapter 28 

What's next? 29 

3 Using the Camera With Your Mac OS-Based Computer 31 
Connecting the camera to your computer 3L 

Using QuickTake Camera Access to work with your camera and images 33 

Connecting to the QuickTake 200 camera 33 

Looking at images in the camera 35 

Getting information about an image 36 

Opening an image to its full size 36 

Transferring images to your computer 38 

Naming images 39 



Uploading: transferring images from your computer to the camera 39 

Moving images between Camera Contents and a Viewer folder 41 

Viewing images on your computer 41 

Deleting images from the camera 43 

Working with your images 44 

Opening and editing images on your computer 44 

Making videos and movies 48 

Creating a movie with images stored on your computer 48 

Creati ng a QuickTime movie 53 

Using the Camera Access Dispatcher to start other applications 55 

Saving an image 59 

Printing your images 59 

Printing a single image 59 

Printing a collection of images 60 

Quitting the QuickTake 200 software 60 

What's next? 60 

4 Maintenance and Troubleshooting 61 
Caring for your camera and lens 61 

Handling the storage card 62 

Solving problems 63 

Appendix A Technical Specifications 67 

Appendix B Battery Information 69 

Appendix C About ColorSync 71 

Appendix D Transferring DOS Images to Mac OS-Based Portable Computers 79 

Index 81 

. 
Contents : v 



Communications regulation information 

FCC statement 
This equipment has been tested and found to comply with the limits for a Class B digital device 
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to 
radio or television reception is suspected. 

Radio and television interference 
The equipment described in this manual generates, uses, and can radiate radio-frequency 
energy. If it is not installed and used properly-that is, in strict accordance with Apple's 
instructions-it may cause interference with radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device 
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed 
to provide reasonable protection against such interference in a residential installation. However, 
there is no guarantee that interference will not occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If 
the interference stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct 
the interference by using one or more of the following measures: 

• Tum the television or radio antenna until the interference stops. 
• Move the computer to one side or the other of the television or radio. 
• Move the computer farther away from the television or radio. 
• Plug the computer into an outlet that is on a different circuit from the television or radio. 

(That is, make certain the computer and the television or radio are on circuits controlled by 
different circuit breakers or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support 
information that came with your Apple product. Or, consult an experienced radio/television 
technician for additional suggestions. 

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc., 
could void the FCC Certification and negate your authority to operate the product. 

This product was tested for FCC compliance under conditions that included the use of Apple 
peripheral devices and Apple shielded cables and connectors between system components. It is 
important that you use Apple peripheral devices and shielded cables and connectors between 
system components to reduce the possibility of causing interference to radios, television sets, 
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded 
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices, 
contact the manufacturer or dealer for assistance. 

Vi Communications Regulation Information 



Industry Canada statement 
This Class B device meets all requirements of the Canadian interference-causing equ ipment 
regulations. 

Cet appareil numerique de la Class B respecte toutes les ex igences du Reglement sur le materiel 
brouilleur du Canada. 

VCCI Class 2 statement 
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Important Safety Instructions 
You 're a lmost ready to get started using your Q uickTake 200 camera, but fi rst read these 
important safety instructions. 

AA 
CAU TION 

A•SIC or [l[Cln c StlOClt DONO ! ori::N 

ATTENTION 
fHsntJE OE Cl'K>C EtECTRIOtJ E M PAS OIJVR R 

A This symbol is intended to alert the user to the presence of uninsulated ''dangerous voltage" 
within the product 's enclosure that may be of sufficient magnitude to constitute a ri sk of electric 
shock to persons. 

A This symbol is intended to alert the user to the presence of important operating and 
maintenance (servicing) instructions in the literature accompanying the appliance. 

WARNING The QuickTake 200 AC Adapter (sold separately) is designed to work with the electrical 
system of the region in which you purchased it. It works with o nly one frequency of elecuicity, 
either 50 or 60 he1tz (Hz). The label on the adapter indicates the frequency required. 

The label on the adapter also indicates the voltage requi red . If you are using the camera in a 
region with a different voltage but the same frequency as that listed on the adapter, you must use 
a voltage converter to provide the voltage ind icated on the adapter label. 

Serious damage to the equipment will result from using the QuickTake 200 AC Adapter with an 
improper electrical frequency or improper voltage converter. Damage resul ting from such 
misuse of the equipment is not covered under warranty. 

Important Safety Instructions vii 



For your own safety and that of your equipment, always take the following precautions. 

Disconnect the power adapter (by pulling the plug, not the cord) if any of the following 
conditions exist: 
• you spill something into the case or other foreign objects have entered 

the equipment 
• your equipment is exposed to rain or any other excess moisture 

• your equipment has been dropped or the case has been otherwise damaged 

• your equipment is emitting smoke, is unusually hot to the touch, is emitting any unusual 
odor or noise, or is in any other abnormal state 

• you suspect your equipment needs service or repair 
• you want to clean the case (use only the recommended procedure described in Chapter 4) 

IMPORTANT The only way to disconnect power completely is to unplug the power adapter. Make 
sure the power adapter is within easy reach so that you can unplug it when you need to. 

Be sure to follow these instructions: 

• Keep your equipment away from sources of liquids, such as washbasins, bathtubs, shower 
stalls, and so on. 

• Protect your equipment from dust and dampness or wet weather, such as rain, snow, and 
so on. 

• Protect your equipment from high temperatures. For example, do not leave the camera in a 
sealed vehicle or direct sunlight. 

• Always use the camera, the AC adapter, and its accessories in well-ventilated locations. 

• Handle and transport the equipment carefully. Do not place the equipment on unstable 
surfaces. 

• Do not insert foreign objects into the card slot. 
• Do not modify or disassemble this equipment. Doing so may cause a fire or electric shock. 
• If you are using the AC power adapter, do not touch the power plug during a thunderstorm. 

Doing so may cause an electric shock. 

• Never use the camera while you are operating a vehicle. 

• Do not place the equipment near cooking areas or humidifiers, where it can be affected by 
oil fumes or steam. Doing so may cause a fire or 
electric shock. 

• Read all the installation instructions carefully before you plug the adapter into a wall socket. 
• Keep these instructions handy for reference by you and others. 
• Follow all instructions and warnings dealing with your system. 

WARNING Electrical equipment may be hazardous if misused. Operation of this product, or 
similar products, must always be supervised by an adult. Do not allow children access to the 
interior of any electrical product and do not permit them to handle any cables. 
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Getting Started With 
the QuickTake 200 Camera 

• • • • • • 

The QuickTake 200 is an easy-to-use digita l camera that produces high­

quality images you can quickly transfer to your Macintosh Operating System 
(Mac OS)-based computer. Using your computer you can man ipulate and 

modify the images to suit your purposes. The QuickTake 200 is a valuable 

tool for graphic artists, publ ishing professionals, and anyone who wants to use 
images to communicate. 

IMPORTANT Save this manual. I t contains important safety a nd operating 
instructions. 

This chapter contains in formation about system requiremen ts; installi ng the 

Q uickTake software, the storage card, and the batteries ; and setting the date 

and time. 



Do you have what you need? 

Be sure you have all the items shown here: 

QuickTake 200 camera 

Mac OS-based 
computer cable 

1~ 
~ 
Storage card 

Optical viewfinder 

AA batteries 

QuickTake CD-ROM discs 

System requirements 

2 Chapter 1 

To use the QuickTake 200 camera with your computer, you need 

• a Mac OS-based 68040 computer or a Power Macintosh computer 

• Mac OS version 7.5 or later 

• QuickTime version 2.0 or later 

• Apple recommends that you have at least 16 megabytes (MB) of random­
access memory (RAM) with at least an 8-MB RAM partition available 

• a hard drive with at least 10 MB available 

• a CD-ROM drive 



Your camera at a glance 

Front view 

Mode dial 

Timer/sleep light 

Back view 

© ... Power switch 

LCD screen 
{liquid-crystal 
display) 

Bottom view 

-:9:-LCD brightness 
dial 

Tripod mount 

Battery door 

~ Action button 

Focus selector 

Camera lens 

Terminal door 

Storage card door 

Carrying strap mount 

Storage card slot 

~lt~~:2:::.. ___ Battery door 

release button 
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The camera mode dial 

Use the camera mode dial to select modes; for example, turn to Computer 
mode to use the camera with your computer. This section describes the modes 

available. See Chapter 2 for information on how to use each mode. 

Icon Mode Description 

s Computer mode Use this mode, along with the included Mac-OS based computer 
cable, to transfer images from the camera to your computer. 
(PC-Mode appears on your LCD screen.) 

<S) Self-Timer mode Use this mode to set the camera to take a picture after 10 seconds. 

•• • • • Record mode Use this mode to take good-quality pictures. 

::::: Record-Fine mode Use this mode when you want the highest picture quality. You can 
also change the date and time in this mode. 

Ci) Play mode Use this mode to view single or multiple camera images on the 
LCD screen. 

(iID Auto-Playback mode Use this mode to automatically play back consecutive frames 
on the LCD screen. You also use this mode to view images on 
your television. 

ii Protect mode Use this mode to prevent images from being erased. 

IOI Erase mode Use this mode to erase a single image, erase all images on the 
storage card, or to format the storage card. 



Installing the QuickTake software 

Before you can transfer images from your camera to your computer, you need 
to install th e QuickThke software on your computer. 

1 Insert the Apple QuickTake 200 Software CD-ROM disc into the CD-ROM drive of your 
computer. 

Note: For information about the second CD that contains other applications, 
see Chapter 3. 

2 Double-click the folder called QuickTake 200 Software to open it. 

3 Double-click the Installer icon to begin the installation process. 

IMPORTANT Do not install the QuickTake software by dragg ing its icons to 
your hard disk. You must use the Installer to install the software on your 
computer correctly. 

4 In the Welcome dialog box that appears, click Continue. 

5 In the Installer dialog box, click Install. 

Easy Install is already selected to ensure that all the necessary software is 
installed. Make sure that you install the software on your startup disk. 

A software license agreement appears. 

6 Read the agreement. 

7 If you agree with the terms of the license, click Agree to continue with installation. 

You may also print the license agreement or save it to your hard disk. If you 
click Disagree, the software will not be installed. 

8 When you see a message reporting that the installation was successful, click Restart. 

The Installer restarts your computer, and a new folder called QuickTake 200 
appears on your hard disk. This folder contains th e Camera Access software. 

[] 
OuickT.:ike 2 00 
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Installing the batteries 

6 Chapter 1 

Before you begin using your camera, you need to install the batteries. Use 
the four lithium batteries (AA size) that came with your camera. To obtain 
maximum use from your batteries, turn off the camera whenever you are not 
using it. 

Uthtum 
(Li) 

WARNING Installing the batteries incorrectly may cause an 
explosion. Follow the instructions in this manual to replace the 
batteries. Use only the same type of batteries or an equivalent 
batteries recommended by the manufacturer of the original 
batteries. Do not mix different types of batteries in the camera. 

Press down on the Push button and slide and open the battery door. 

2 Insert the batteries into the camera as shown. 

Battery door 

3 Close the battery door by sliding it into place. 

See alw: Appendi x B, "Battery Information." 



Lithium 
(LI) 

Replacing the batteries 

When the batteries are low, the battery warning flashes on the liquid-crysta l 
display (LCD) screen to remind you to replace the batteries. The camera turns 
itself off when the batteries get too low to use. 

IMPORTANT Do not use old and new batteries together or batteries of different 
types together. 

IMPORTANT Batteries contain chemicals, some of which may be harmful to 
the environment. Please dispose of used batteries according to your local 

environmental guidelines. 

Installing the storage card 
Before you can use your QuickTake 200 camera, you must install the storage 

card that you received with the camera. After you install the card, you need to 
format it using the Erase mode Format function. (You format the card the first 

ti me that you use it in the camera.) 

WARNING The use of storage cards other than that specified for use with 
your camera may result in damage to your camera. 

If the card is not in the camera, a NO CARD message flashes on 
the LCD screen when you turn on the camera. You cannot take pictures 

without a card. 

Getting Started With the QuickTake 200 Camera 7 
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Open the storage card door. 

Storage card door 

IMPORTANT Opening the storage card door always turns off the camera. 

2 Hold the card as shown, and gently push it all the way into the card slot. 

3 Close the card door. 

IMPORTANT When storing the camera, you should remove the card a nd store it 
in its plastic case. 



Formatting the storage card 

Turn on the camera by sliding the power switch (<D~) (above the LCD screen) in the 
direction indicated by the arrow and then releasing it. 

2 To format the storage card, turn the mode dial to Erase (DD) mode. 

3 Use the plus(+) and minus(-) buttons (next to the mode dial) to select FORMAT on 
the screen. 

4 Press the action button (next to the+ and - buttons). 

OK? appears blinking on your screen. 

5 Press the action button again to format the card. 

WARNING When you format a card, all the data on the card is removed, 
including any protected images. 

Write-protecting the storage card 

To prevent erasing important data from your storage card, place a write­
protect seal over the write-protect circle on the card. You receive 4 seals with 
every card you buy. (You cannot reuse seals.) 

This seal makes it im possible to record data to or erase data from the card. 
To again use the card to record or erase data, remove the seal. 

IMPORTANT Write-protection might not function if the seal becomes dirty. Use 
a dry, lint-free cloth to wipe the seal clean. 

Getting Started With the Qu ickTake 200 Camera 9 



Attaching the carrying strap 

10 Chapter 1 

Always use the carrying strap to avoid dropping the camera. 

Pass the end of the strap through the strap mount on the camera. 

Strap mount 

Strap 

2 Pull the strap through the strap fastener. 

Loop the carrying strap over your wrist before grasping the camera. 



Setting the date and time in the camera 

You can set the date and time to date-stamp your images. The date and 

time are automatical ly recorded and appear on the LCD screen or the 
television monitor. 

1 Turn the mode dial to Record-Fine (::;:;) mode. 

2 Hold down the plus(+) and minus(-) buttons at the same time for 3 or more seconds. 

The date appears with the year flashing. 

3 Press the+ button to change the year. 

IMPORTANT If you advance beyond the number that you want to set, continue 

pressing the + button. Whe n the highest number is reached, the display 
goes back to the lowest number. For example, when you set the month , the 

display goes from 12 back to J. 

4 Press the - button to set the year and advance to the month. 

The month appears flashing. 

IMPORTANT Press the - button only when you want to set your choice. You cannot 
use the - button to go backward if you pass the number that you wanted. 

5 Repeat steps 3 and 4 to change and set the month, day, and time. 

Press the+ button to advance the number flashing. Press the - button 

to set the flashing numbe r and move to the next setti ng. The time appears 
after you set the day. 

IMPORTANT To set AM and PM, you must advance the hours using the + button. 

Getting Started With the QuickTake 200 Camera 11 



6 After you set the number for minutes, press the - button again. 

T he date and time are now set. 

Displaying and hiding the date and time 

You can display and hide the date and ti me on your LCD screen when you are 
using either Record-Fine or Record mode. 

Press the + button to display the date and press again to hide it. 

Press the - button to display the time and press again to hide it. 

IMPORTANT The date and time remain set for up to 5 mi nutes while you 
change the battery. You must reset the date and time after 5 mi nutes have 
elapsed without batteries in the camera. 

What if you upgrade your system software? 

What's next? 

12 Chapter 1 

If you decide to replace or upgrade your system software after you've installed 
the QuickTake software, you• might not be able to connect to the camera. You 
must re install the Apple QuickTake 200 software. See "Installing the 
QuickTake Software," earlie r in this chapter. 

Read Chapter 2 for instructions about how to take pictures with your 
QuickTake 200 camera. 



Using the Camera to Take Pictures 
• • • • • • 

This chapter provides information about turning on the camera and taking 
pictures; using the optical viewfi nder; using the camera mode dial; the 
auto-power-off function ; and using the camera with the optional AC 

power adapter. 

Turning on the camera 

To turn on the camera, slide the power switch (CD .... ) (above the LCD screen) 
in the direction indicated by the arrow and then release it. 

© .... Power switch 

13 



When the camera is on, the LCD screen displays live, video images. If the 
camera does not turn on, check to make sure that you've installed the 
storage card and the batteries correctly (see Chapter 1 ). Also make sure that 
the card door is closed and that the mode dial is correctly positioned. 

• Turn the mode dial to the Record-Fine (:::::) mode when you want high­
quality images, and you want to preserve the details of the image. 

• Turn the mode dial to the Record(:•:) mode when you want good-quality 
images, but you don't need to show as much detail. 

To turn off the camera, again slide the power switch (CD.-) in the direction 
indicated by the arrow and then release it. 

IMPORTANT When not using your camera for long periods or when you store 
the camera, remove the storage card and keep it in its plastic case. 

Taking pictures 

1 Turn the mode dial to Record-Fine(:::::) or Record(:•:). 

The LCD screen displays live, video images. 

2 Take time to frame the subject that you want to photograph using the LCD screen. 

14 Chapter 2 



3 Hold the camera steady, and press the shutter release. 

The screen displays a still image (the picture that you just took) for about 5 to 
8 seconds with REC or REC-FINE flashing in the upper-left corner of the 
screen. When the camera is ready for you to take the next picture, REC or 

REC-FINE stops flashing and the live, video images resume. 

Shutter release 

You can hold the camera horizontally or vertically. 

Frame numbers 

A frame number is automatically assigned to each photograph that you take. 
It appears in the top-right corner of the LCD screen during Play, Auto-Play, 

Erase, and Protect modes when you have screen information displayed. (To 
hide or show LCD screen information, press the action button.) 

Frame numbers are assigned a 5-digit number from 00001 to 30000. If you 
take pictures without erasing all previous images, the frame numbers continue 
from the last image that you captured. 

Using the Camera to Take Pictures 15 
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Setting the focus 

Use the focus selector to set the distance from the lens to the subject. 

Focus selector 

Estimate the focal distance from the front surface of the LCD screen to the object 
being photographed. 

2 Set the focus for the correct distance: 

Icon Name 

Close-up 

Portrait 

Far 

Description 

3.5 to 5.1 inches (9 to 13 cm) 

17.7 to 35.4 inches (45 to 90 cm) 

35.4 inches and farther (90 cm and farther) 

For close-up images, you can set the focus between close-up and portrait. 

IMPORTANT Do not use the close-up focus when you use the viewfi nder. It is 

not accurate. 



Selecting the aperture 

Selecting the aperture (the light setting) for your camera is a simple process. 
(The aperture is the opening in the lens that lets in light.) You can switch the 
aperture between f2.2 and f8.0. Use the 0 (f2.2) setting when you have low 
light, and use the 0 setting (f8.0) when you have bright light. 

Aperture selector 

If the overexposure (0~) warni ng is flashing on the LCD screen, indicating 
too much light, change the setting to 0 (f8.0). 

If the underexposure (~O) warning is flashing on the LCD screen, indicating 
too little light, change the setting to() (f2.2). 

Adjusting the LCD screen brightness 

Use the brightness dial on the bottom of the camera to set the LCD screen to 
a visible brightness. Note: While taking pictures indoors, the brightness of a n 
image might be affected by the flicker of fluorescent lighting. 

IMPORTANT The brightness dial does not adj ust the brightness of images that 
you have already taken; it only adjusts the brightness of the LCD screen. 

Brightness dial 
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Using the optical viewfinder 

18 Chapter 2 

Attach the optical viewfinder to your camera to use when you are taking a 
series of pictures, when you want to conserve the batteries, or when you are 
outdoors and sunlight is distorting the LCD screen view. 

Note that when you use the viewfinder, you will not be able Lo tell whether 
the aperture setting is correct before you take the picture, because the LCD 
screen is asleep. However, the overexposure or underexposure warning will 
appear flashing on the screen after you take the picture if the condition exists. 

IMPORTANT Do not use the close-up focus with the viewfi nder; it is not 
accurate, because the parallex correction is off. 

To install the optical viewfinder, hook the viewfi nder to the front of the 
camera first, then hook it to the back of the camera. Remove it in the same 
way; don't pull the viewfinder off the camera. 

Optical viewfinder 



Press the action bullon twice when the camera is in Record-Fine or Record 

mode. The LCD screen turns off and the red sleep light on the front of the 
camera goes on. When you press the shutter, the LCD screen turns on and 
lets you review the image. Then the LCD screen turns itself off again. To 
reactivate the LCD screen, press the action button twice again. 

While you are framing your picture, use the viewfi nder's clear, center circle as 

a reference point for the center of the picture. 

For more information about using the viewfinder, see "Battery-Saving Mode," 
later in this chapter. 

Using the camera mode dial 

The mode dial on the right side of the top of the camera provides eight 
settings (represented by icons) that let you choose how you want your camera 
to work. 

Record-Fine and Record modes for taking pictures 

You take pictures by turning the mode dial to either Record-Fine(:::::) for 
highest-quality images or Record (:•:) for good-quality images. 

Record-Fine mode Record mode 

• In Record-Fine(::::: ) mode, high-quality images have 640 x 480 pixels 
resolution and you can take up to 20 high-quality pictures. Use Record­
Fine mode to print or display the image when you want to preserve the 
details of the image. 

Using the Camera to Take Pictures 19 
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• In Record(:•: ) mode, good-quality images have 640 x 480 pixels resolution, 
and you can take up to 30 standard-quality pictures. Use Record mode 

when you don't need to show as much detail. 

You can mix high-quality and standard-quality images on the camera-all in 
24-bit color. The camera holds a maximum of 30 images. 

Set the mode dial to either Record-Fine(:::::) or Record (:·:). 

Live, video images appear on the LCD screen. 

2 Frame your picture using the LCD screen as your guide. 

3 Adjust the brightness of the LCD screen using the brightness dial and select the correct 
focus using the focus selector. 

4 Press the shutter release. 

The photographed image is displayed for about 5 to 8 seconds. REC or REC­

FINE (to indicate that the camera is recording) appears flashing in the upper­
left corner of the LCD screen. 

WARNING Never open the storage card door while the camera is 
recording an image. This can damage the card or corrupt data on the 
card. You might have to reformat the card, which means that all the 
images on the card will be erased. 

Images available 

When the LCD display is on, the number in the upper-right corner of the 
LCD screen shows how many more pictures you can take. The number 
decreases as you take pictures, and indicates the number of pictures you can 
take at the current image quali ty before the card is fu ll. 



Self-Timer mode 

You can take delayed photographs by turning to the Self-Timer (<S>) mode on 
the mode dial. This setting uses the Record-Fine mode. 

Set the mode dial to Self-Timer (<S>}. 

2 Press the shutter release. 

The LCD screen displays the countdown-from 10 to I. The shutter opens 
after 10 seconds and the camera captures the image. ( REC flashes in the 
upper-left corner of the LCD screen while the image is being recorded.) 

On the front of the camera, the red self-timer light stays on for 5 seconds and 

then flashes for 5 seconds. 

3 To stop the timer, turn the mode dial to another setting. 

Play mode for the camera and the television 

Use the Play (Ci)) mode to view the images in the camera on your LCD screen 
or on a television screen. 

To view one image on the LCD screen 

Plug the optional AC power adapter into your camera to conserve the batteries. 

See "Using the Camera With the Optional AC Power Adapter," later in 
this chapter. 

2 Set the mode dial to Play (Ci)}. 

The last image that you captured is played back. 

3 Use the+ and - buttons to scroll forward and backward one frame at a time through 
your pictures. 

4 Press the action button to show the Play mode, the frame number, and the date and the 
time on the LCD screen. 

Press the action button again to hide this information. 
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Viewing nine images on the LCD screen 

Plug the optional AC power adapter into your camera to conserve the batteries. 

2 Set the mode dial to Play (Ci)). 

3 Press the + and - buttons at the same time. 

Nine images appear on your LCD screen. 

4 Press the + and - buttons to select and view the frames. 

5 To revert to single-frame playback, press the+ and the - buttons at the same time again. 

A single image appears on your LCD screen. 

Viewing images on a color television 

IMPORTANT Your television must meet NTSC (National Television System 
Committee) color television telecasting specifications (adopted mainly in the 
United States, Canada, and Japan). 

1 Make sure the camera and television are turned off. 

2 Plug the optional power adapter into your camera to conserve the batteries. 

See "Using the Camera With the Optional AC Power Adapter," later in 
this chapter. 

3 Set the mode dial to Play (Ci)). 

4 Connect the video cable to the Video Out port on the camera. 

Video Out port 

Video cable 

5 Connect the other end of the video cable to the video input port on the television. 

6 Turn on the camera. 



7 Use the+ and - buttons to scroll forward and backward one frame at a time through 
your pictures. 

8 Press the +and - buttons at the same time to view multiple images on your television screen. 

Auto-Play mode 

Use the Auto-Play (®J) mode to have the camera automatically play back 

consecutive frames of images. 

Set the mode dial to Auto-Play(®!). 

The Auto-Play settings appear on the LCD screen. 

2 Press the+ or- button to select 3, s, or 10 seconds between each frame. 

3 Press the action button to begin viewing the images. 

Using Auto-Play mode with your television 

You can also use the Auto-Play (®!) mode to play back consecutive frames of 
images on your television. 

Follow the steps in Play mode to connect the camera to the television. 

2 Follow the steps in Auto-Play mode to view images on your television. 

Computer mode 

In Computer (S ) mode, you can connect your camera to your computer to 

transfer pictures a nd perform other camera functions using the Camera 
Access software (see Chapter 3 for more information about Camera Access). 

Turn off the camera. 

2 Set the mode dial to Computer ( S ). 

3 Connect the computer cable to the Digital port on the camera. 

4 Connect the other end of the computer cable to the modem or printer port. 

Apple recommends that you connect to the modem port. 

5 Turn on the camera. 

PC-MODE appears on the LCD screen. 

6 To open the Camera Access application, double-click the icon on your computer. 
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See Chapter 3 for more information abo ut using the Camera Access software 

with your computer. 

Erase mode 

When the came ra is in Erase (Uii) mode, you can erase a single frame, e rase a ll 

the frames on the storage card, or format the card before you use it. 

Reme mber, you cannot erase protected images. 

IMPORTANT You cannot use Erase mode with write-protected cards. 

Turn the mode dial to Erase (Uii). 

The ERAS2 - MODE selections appear on the LCD screen. 

2 Use the plus +and minus - buttons to select the function that you want. 

• FRAME : Erase one image. 

• ALL : Erase all images. 

• FC?RMAT : Format a s torage card. 

IMPORTANT See Chapter 1 for information about formatting a card. 

3 Press the action button. 

T he fu nction you selected appears in the upper-left corner of the LCD screen: 

ERASE FRAME or ERASE ALL . 

4 Press the action button again. 

OK? fl ashes on your screen, g iving you a chance to verify that you wan t to 

erase the image. 

5 Press the action button a third time to erase the image. 

If you selected ERASE FRAME , the next image appears on the screen. You 

can continue to erase frame-by-frame or sk ip a frame by moving forward or 

backward using the+ and - buttons. 

6 Turn the mode dial to leave Erase mode. 



Viewing nine images in Erase mode 

Set the mode dial to Erase (OD). 

2 Press the action button to select ERASE FRAME. 

3 Press the+ and - buttons at the same time. 

N ine images appear on your LCD screen. 

4 Press the + and - buttons to select a frame. 

5 Press the action button again to erase the frame. 

OK? flashes on your screen, giving you a chance to veri fy that you want to 

erase the image. 

6 Press the action button a third time to erase the image. 

7 To revert to single-frame playback, press the+ and - buttons at the same time again. 

A single image appears on your LCD screen. 

Protect mode 

Use Protect(• ) mode to assign read-only, protected status to an image to 

prevent it from being erased. 

IMPORTANT Even protected, read-only images are erased when th e storage 

card is formatted . (See Chapter 1 for more information about formalling 

the card.) 

Set the mode dial to Protect (•). 

2 Press the plus + or minus - button to select the frame that you want to protect. 

3 Press the action button. 

T he image is now protected and cannot be erased. The protection icon 

appears next to the image number on your LCD screen when you view 

this image. 
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Note: After you transfer your images to the computer, you can erase all the 

images from your camera. However, the images that you have protected are 

not erased. 

To remove protection 

W hile the camera is in Protect mode, select the protected frame, and press the 

action button again. The protection icon disappears and the image is no 

longer protected. 

Battery-saving mode 

26 Chapter 2 

To conser ve your batteries, you can turn off your LCD screen and sti ll take 

pictures using the optical viewfinder. 

Attach the optical viewfinder to your camera. 

2 Turn on the camera using the power switch (CD~). 

3 In either Record or Record-Fine mode to take pictures, press the action button twice to 

put the LCD screen to sleep. 

The red sleep l ight on the front of the camera goes on. You cannot see live, 

video images on the LCD screen when you put the screen to sleep. 

4 Use the viewfinder to focus on the image that you want to capture. 

5 Press the shutter release to take a picture. 

T he LCD screen turns on and captures the image. T he image appears on the 

screen for about 5 to 8 seconds allowing you to review the picture th at you 

just captured, and then the screen goes to sleep-ready for you to take 

another picture. 

6 Press the shutter release again to take another picture. 

IMPORTANT Press the action button once to again turn on the LCD screen. 



Auto-power-off function 

Your camera automatically switches itself off when you do not use it for 
more than 2 minutes as a way to conserve batteries and to save power 
when you use the optional AC power adapter. 

IMPORTANT The auto-power-off function does not operate in Computer mode. 

To disable the auto-power-off function in al I modes, hold down the action 
button while turning on the camera. The camera will continue to use battery 
power even if you do not use it for several minutes. When you turn off the 
camera and then turn it back on, auto-power-off is again enabled. 

It is especially good to disable auto-power-off when you are using a television 
to view images or when you are record ing a video; you do not want the 

camera to turn off during those operations. 

IMPORTANT You should always use the optional power adapter when you 
d isable the auto-power-off function. 
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Using the camera with the optional AC power adapter 
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To conserve battery power whe n you use the camera indoors, use the optional 
AC power adapter plugged into an available power outlet. 

WARNING Use only the QuickTake 200 AC Adapter with the QuickTuke 
200 camera. The use of other power sources might cause a fire. 

With the camera turned off, connect the adapter to the camera DC IN 6V 

socket, plug the adapter into an outlet, and then turn on the camera. 

DC IN 6V socket 

Use the optional AC power adapter when you play back and erase images, 
for power while the camera is connected to your computer or television, and 

when you disable the auto-power-off fun ction. 

Note: The power adapter does not recharge batteries in the camera. If you 
have rechargeable batteries, use a charger designed for them. 

WARNING Never alter the plug on the power adapter. If it will not fit an 
electrical outlet, have a proper outlet installed by a qualified electrician. 
Improper connection may result in electrical shock. Use of a power 
adapter not recommended or sold by Apple Computer, Inc., may result 
in a risk of fire, electrical shock, injury, or damage to the camera. 



What's next? 

Now you're ready to transfer the pictures that you've taken from the camera 
to your computer. Read Chapter 3 for instructions about connecting the 
camera to your computer and transferring images-and about using the 

Camera Access software. 
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Using the Camera With Your 
Mac OS-Based Computer 

• • • • • • 

When you fini sh tak ing pictures (or whe n the storage card is ful l), you can 
connect the QuickTake 200 camera to your Mac OS-based computer and then 
transfer the images to th e computer. This chapter provides in formation about 
connecting the camera to your computer; transferring images to your 
computer; opening, ed iting, and pri nting images on the computer; creating 
movies; and using the Dispatcher with third-party applications. 

Connecting the camera to your computer 

To connect the camera to your Mac OS- based computer, use the serial cable 
that came with your camera. 

IMPORTANT Apple recommends that you use the optional QuickTake 200 
AC Adapter whenever your QuickTake camera is connected to the computer. 

Turn off the camera by sliding the power switch (<D,... ). 

2 Connect one end of the serial cable to the modem or printer port on your computer. 

Apple Computer recommends that you use the modem port, but either port 
will work. 

IMPORTANT You cannot use the printer port (or the combined serial port) 
whe n the port is used by AppleTalk. To use the printer port, you can turn off 
AppleTalk or you can select another form , such as Ethernet or Remote-only. 
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These icons identify the printer and 
modem ports on your computer. 
Connect the camera to either port. 

Some Mac 08-based computers have 
a combined serial port with two icons. 

If both ports are in use, free the one that's most convenient and connect 
the camera, but Apple recommends that you always try to use the modem port. 

IMPORTANT It is not necessary to turn off your computer before you connect 
and disconnect the serial cable. However, if you want to connect or 
disconnect other devices, in many cases you must turn off the computer 

·before you connect or disconnect a cable. 

3 Connect the other end of the cable to the Digital port on the camera. 

Digital port 



4 Turn the mode dial to Computer (S). 

5 Turn on the camera by sliding the power switch (<D .... ). 

When the camera is connected and turned on, PC-MODE appears on the 
LCD screen. 

Using QuickTake Camera Access to work with your camera and images 

QuickTake 200 Camera Access software lets you perform the following tasks: 

• connect to the QuickTake 200 camera 

• look at images in the camera 

• transfer images from the camera to your computer 

• delete images from your camera 

• open and edit your images 

• place images in other application programs 

• create and run movies 

• pri nt images 

Connecting to the QuickTake 200 camera 

The Camera Access application appears as a camera icon on the desktop for 
convenient access to images in the QuickTake 200 camera. 

Make sure the camera is connected to your computer. 

2 Turn the mode dial to Computer (S). 

3 Turn on the camera by sliding the power switch (<D .... ). 

4 Double-click the Camera Access icon on your computer to open it. 

Camet· a Acc:ess 
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Click to view 
camera contents. 
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The Camera Access Welcome message appears briefly, then the QuickTake 200 
panel appears. 

Apple CoMputtr, lno. 

~ ~ Images: 12 

000 
000 
Ulewer Uplood 

Number of images in 
the camera 

Click to move an image from 
the computer to the camera. 

The QuickTake 200 panel contains two buttons: the Viewer button to view 
your camera's contents and the Upload button to move images from your 
computer to your camera. You can also tell at a glance how many images 
are stored in your camera. 

IMPORTANT When your camera is not connected to the computer or not 
turned on, the QuickTake 200 panel is disabled. 

loOOl 
~ 

Number of images in the 
camera does not appear. 

You cannot work with your camera's contents, but by using the panel menus 
you can open and edit Camera Access images that have already been 
transferred to your computer. 



Looking at images in the camera 

You can view the images in your camera by connecting the camera to your 
computer and viewing them on the computer screen. 

IMPORTANT To conserve battery power, transfer images to your computer's hard 
disk before you view or work with them, or use the optional QuickTake 200 
AC Adapter while the camera is connected to the computer. After the images 
have been transferred, turn off the camera and open the images from your 
computer's hard disk using Camera Access. 

Connect the camera to your computer. 

For instructions, see "Connecting the Camera to Your Computer," earlier in 
this chapter. 

2 Turn the mode dial to Computer (S). 

3 Turn on the camera by sliding the power switch (CD ..... ). 

4 Double-click the Camera Access icon in the QuickTake 200 folder to open it. 

If Camera Access is already running when you turn on your camera, the 
QuickTake 200 panel becomes active. 

5 In the QuickTake 200 panel that appears, click Viewer. 

Click to view 
image information. 

The images appear in a Camera Contents window on your computer screen. 

~Iii Camera Cont ents • Iii 
~ 

j_ 

·J 
j_ 
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' 
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The Camera Contents window represents all the images in your camera that 
have not yet been downloaded to your computer. 
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For information about what you can do with the images, see "Working With 
Your Images;' later in this chapler. 

Getting information about an image 

In the Camera Contents window, click an image to select it. 

2 Choose Get Info from the File menu or click the "i" in the upper-right corner of the 
image frame. 

An information box appears. 

=0 lma..9_e 6 Info 
Type : PICT 

Size : 250K bytes 

Created: Fri, Jan 10, 1997 
11 :49 :06 AM 

Modified : Fri, Jan 10, 1997 
2:58:16PM 

Image Depth : Millions of Colors 

'w'idth : 640 Pixels 

Height : 480 Pixels 

Opening an image to its full size 

To see an image full-size, double-click the thumbnail image in the Camera 
Contents window (or in a Viewer folder; see the following sections). A progress 
bar appears, followed by the full-size image. 

To open more than one image, click one image, then Shift-click and double­
click the next image. 



lmll e 2 

Click to view the 
Scale pop-up menu. ---1---~ 

To see a portion of the image enlarged, choose the Zoom In command from 
the Image menu. To reduce the image, choose the Zoom Out command. 

You can also reduce and enlarge the image usi ng the Scale pop-up menu 
located in the lower-left corner of the screen. 

400% 
300% 
200% 
150% 
100% 
75% 

• 50% 
25% 
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Transferring images to your computer 

Connect the camera to your computer to transfer images. For instructions, see 

" Connecting the Camera to Your Computer," earlier in this chapter. 

IMPORTANT Apple recommends that you transfer all your images from the 

camera to the computer before you work with them. This w ill result in better 

performance and wi ll conserve batteries. 

Turn the mode dial to Computer (S). 

2 Turn on the camera by sliding the power switch (<D,...). 

When the camera is turned on and the serial connector is plugged in, 

PC-MODE appears on the LCD screen. 

3 On your computer, double-click the Camera Access icon. 

The QuickTake 200 panel appears. If Camera Access is already running, the 

panel becomes active after you attach your camera and turn the mode dial to 

Computer mode('$). 

4 Click the Viewer button. 

A Camera Contents window appears showing all the images in you r camera. 

5 From the Viewer menu, choose "Copy All Images to Disk." 

·m 
Copy Selected I mag es to Disk ... 

-11· · ·•· Jl; 1 • :!IIU; 

Delete Selected Images fom Camera ... 
Delete All Images from Ca mera ... 

6 To transfer only selected images, select one or more images (using Shift-click) and then 

choose "Copy Selected Images to Disk." 

7 In the dialog box that appears, create a new folder for your images. 

8 In the Image File Name Prefix box, type a prefix name that will be assigned to this group 

of images. 

T he images are saved on your hard drive in the folder you created, each 

showing the prefix you assigned. 



Naming images 

After you transfer images to your computer, you can re name each file. You 
can change the name of the file using the Finder. When you use Save As, you 
can rename an image or you can change the name on your desktop. 

Whe n you move images to your computer, you also have the option to assign a 
new prefi x to all the images that you copy. When you choose "Copy All 

Images to Disk" or "Copy Selected Images to Disk," a dialog box appears in 
which you can select a folder to save your images and type an Image File 

Name Prefix to assign to all the images that you are saving to your computer. 

For example, each image has the prefi x "Image." You can cha nge that to 

"Book" to indicate images that you are going to use to put together a book. 

Uploading: transferring images from your computer to the camera 

You can transfer images q uickly from your computer to the camera using 
the Upload button on the QuickTake 200 panel. You can upload any image 
as long as you have enough memory to convert the file to a type compatible 
with your camera. 

With the camera attached to your computer, turn the mode dial to Computer (S) mode. 

2 Turn on the camera and the computer. 

3 Click the Upload button in the QuickTake 200 panel. 

Upload 

You can also choose the Upload Image command from the QuickTake 200 menu. 

4 Choose a folder, and click the name of the image that you want to move to your camera. 
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You can always upload images created with Camera Access; but otherwise, 
with images created by other applications, you can upload only PICT and 

JPEG files to the camera. 

Preuiew 
lesi I moqes • I 

~Book 011 ft 
= Macintosh HO 

( JCC I 
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$ Book 01 3 r-Ji\ Book O 14 r-
Ji\ Book o 15 
.\fl Book o 16 

~ 1ii Book 017 

Desk top 

( Cance l ) 

~ ~ Open 

181 Show Preuiew 

5 Click Open to upload the image. 

The image is now part of your camera contents. It appears in the Camera 
Contents viewer with an image number assigned to it. Any image name is 
replaced with an image number. 



Moving images between Camera Contents and a Viewer folder 

Another easy way Lo transfer images is to open the Camera Contents window 
and a Viewer folder and then simply drag and drop images between the 
folders. That's it! The image you drag is moved to the Viewer folder or 
uploaded to the camera. 

=- Comero Contents 

.i 

lm19<6 lm~7 ~ 

"Book Imo es · Folder Contents 

. -i l i I . 

. 
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~ 
~ 

l 
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lm'90 5 --lm>9t 6 _ _f lrM9< 7 ~8 

Viewing images on your computer 

After you transfer images to your computer, you can view thumbnails of a ll 
the images in a folder. You can also open a viewer of other folders that 
contain PICT or JPEG images created in o ther applications. 

Open the Camera Access application. 

Your camera does not need to be connected to the computer. 
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2 From the File menu, choose Open Folder Viewer. 

Open Folder Uiewer ... 3€T 
Open ... 

Close 
Saue 

3€0 

The "Select a Folder" dialog box appears. 

3 Locate the folder that contains the images that you want to view and click Select 
<folder name>. 

Click the Select 
button to open a 
folder of images. 
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You are not selecting a file; you are selecting a folder of images. 

Select a Folder: 

I 61 1 moges ..,.. I = Macintosh HO 

II Book images 

Select "Book lmoges" 

0 ( Ej<HI J 
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[ Desktop J 

(New Folder) 

( Concel I 
Ir Open l) 

The Folder window appears. 

- • Book Ima es· Folder Contents -

.l 

1 ~l r 

Im~ lm19t 2 ™..!! 3 

.l .ii 

J lml<,lt6 lmiqt 7 

.ii 

lml<,lt 4 

lmocJt 8 1 

11r 
fl' 

'°' Hi 



4 Choose "View by Name" or "View by Date" from the Viewer menu to change how you 

view the contents of the folder. 

The images appear in the order that you want. 

Deleting images from the camera 

After you tran sfer your images lo your computer, you can use the Viewer 
me nu to delete them from the camera to make room for new images. 

IMPORTANT You cannot de lete images that have been protected. 

Select the images that you want to delete. 

To select more than one image, Shift-click. 

2 From the Viewer menu, choose "Delete Selected Images from Camera." 

:.ir1 ·um 
Copy Selected Images to Disk ... 
Copy All Images to Disk ... 

-j:rnJ :J~'fi •rill"•~· ili[ij] lJijT· 
~ Delete All Images from Camera ... 

To delete all images, choose " Delete All Images from Camera." All the 
images in your camera (except protected images) are deleted . 
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Working with your images 

44 Chapter 3 

Whether your images are in the camera or have been moved to your 

computer, you can use the QuickTake software to look at them, make changes, 
and save the images in a variety of formats. 

Opening and editing images on your computer 

You can double-click an image in the Camera Contents viewer or open it 
from your computer. You can then edit your images usi ng Camera Access or 
your favorite application. (See " Using the Camera Access Dispatcher to Start 
Other Applications," later in this chapter.) 

Adjusting the brightness and contrast of an image 

If you capture an image that seems too light or too dark, you can adjust its 
brightness using Camera Access. 

Open the image that you want to work with. 

2 From the Image menu, choose "Brightness and Contrast." 

Zoom In 
Zoom Out 

Crop 

31:= 
31:-

Brightness and Contrast ... 
Adjust 
Flip 
Rotate 



3 Drag the sliders to adjust the brightness and contrast of your image. 

Brightness/ Controst 

Brightness @==:J 
( Q; I 

IODI 
11 I I I 111 I I I I I 1 1 I I I I 

- 1 00 -50 0 • 50 + 1 00 

Contrast @==:J 
( 0 ) 

1 1 I I I I I I I I I I I I I I I I I I r8l Preuiew 
- 100 - 50 0 •50 +100 

4 Click OK to accept changes. 

Adjusting the lightness and sharpness of an image 

Open the image that you want to adjust. 

2 From the Image menu, choose Adjust to see the selections. 

Zoom In 
Zoom Out 

Crop 

Brightness and Contrast... 

Darken 
Flip 
Rotate 

~ Lighten 
~ Sharp en 

'------------i Soften 

2 Choose either Darken or Lighten. 

T he image is lightened or darkened accordingly. If you're not satisfi ed, choose 
Undo from the Edit menu. You can use Lighte n and Darken until the image 
has the appearance that you want. 

3 Choose either Sharpen or Soften. 

The image is sharpened o r softened accordingly. If you're not satisfied , 
choose Undo from the Edit menu. You can use Sharpen and Soften until the 
image has the appearance that you want. 
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Cropping an image 

You can use the Crop command to select part of an image and delete the rest. 

Open the image that you want to crop. 

2 Click and drag the crosshair cursor to define the part of the image that you want to keep. 

3 From the Image menu, choose Crop. 

After you select part of an image, the Crop command is enabled and appears 
in the menu. 

mn: . ffill 
Zoom In :IC= 
Zoom Out ac-

Crop 

Brightness and Contrast... 

Adjust ~ 
Flip ~ 
Rotate ~ 



Only the part of the image defined by the marquee remains. Choose Undo 

from the Edit menu if you are not satisfied with the cropping. 

4 Save your image. 

J;J lmtt e 2 
Q 

s .. i. 100% • .:>I 

Flipping an image 

You ca n flip an image horizontally or vertically. 

Open the image that you want to flip. 

2 From the Image menu, choose Flip and select either Horizontal or Vertical. 

Zoom In 
Zoom Out 

Cr op 

3€= 
3€-

Brightness and Contrast ... 
Adjust ~ 

Rotate 
Horizontal 
Uertica l 

Your image is flipped the way you selected. 
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Rotating an image 

You can rotate an image to th e left or to the right. 

Open the image that you want rotate. 

2 From the Image menu, choose Rotate and select either Left or Right. 

Zoom In 
Zoo m Out 

Crop 

Brightness and Contrast... 
Adjust ~ 

Flip ~ ......._ _ ____, 
Rotate ~ Left 

Right 

Your image is rotated in the selected direction. 

Making videos and movies 
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Using the Camera Access software you can create your own movies using still 

images stored on your computer, and you can make your own videos usi ng 
the camera. 

IMPORTANT Apple recommends that you use the optional AC adapter 

whenever your camera is connected to your computer. 

Creating a movie with images stored on your computer 

You can create a movie by dragging and dropping images onto the QuickTime 

Screen. You can then run your movie on your computer. 

Open the Camera Access application. 



2 Choose New Movie from the File menu. 

Open Fo lder Uiew er ... :!CT 
Open ... 3€0 

Close WW 
Saue ~s 

Saue As ... 

Get Info 3€ 1 

Page Se tup ... 
Print... 31JP 

Quit 3€0 

3 In the Save dialog box that appears, type the name for your movie in the "New file name" 
box and click Save. 

IG Mouie,.., = Macintosh HO 

~ E.Jetl 

Deskt op ) 

New CJ ) 

New file name: ( Cancel ) 

j~M_o_ui_e _ ______ ~I ([ Saue JI 

T he QuickTime IC movie panel appears. 
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4 Choose Open Folder Viewer. 

You can arrange the images in one folder before you start for convenience, or 
you can open several folders to get the images that you want. 

5 Drag and drop the images from the folder window to the QuickTime IC movie panel in the 
order that you want them to appear. 

Mou le -Iii "Book Ima es• folder Contents 

.. ···~ ... .. .. · 
••• tnq4 

Click the arrow to 
review your images. 
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lrMQ< 6 

You are limited in the number of images you use only by memory. 

6 Click the scroll arrow in the lower-left corner of the QuickTime IC movie panel to preview 
your images. 

7 Choose Present Movie from the Movie menu. 

A checkmark appears next to Present Movie and the QuickTime IC panel 
appears first. 



8 Click the Run Movie arrow in the lower-left corner of the movie panel. 

Click to run 
your movie. 

The arrow changes 
to a double bar. 

Each of your images appears in the order you placed them in a movie slide 
show. When all the images have appeared, the movie stops. The arrow 
changes to a double bar while the movie is playing. 

9 Choose Present Movie from the Movie menu to return to the desktop. 

Your movie fi le sti ll remains for you to run and edit it. After you close the 
movie file, you can also double-click the movie icon from within the Finder 
and run the movie. 
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The Movie Menu 

11.Wl • llI c::m 
Loop 3€L 
Loop Back and Forth 

Half Size 3€0 
Normal Size 3€ 1 
Double Size 3€2 
Fill Screen 3€3 

./ Present Mouie WM 

Recompress Mouie ... 

• Loop Choose Loop to continuously run your movie from beginning to e nd . 

• Loop Back and Forth Choose "Loop Back and Forth" to run your movie 
continuously starting with the first image to the last and the n going 
backwards by running the movie from the last image to the first. 

• Size Choose one of the sizes to change the size of your movie panel. 

• Present Movie Choose Present Movie to run your movie; a checkmark 
appears. Choose Present Movie again to stop playing; the checkmark 
disappears. 

• Recompress Movie For information about recompressing your movie, see 
your Apple Video Player documentation. 

Note that you can also use the Edit menu to cut, copy, and paste images and to 
undo your commands. 



Creating a Quicklime movie 

You can create a QuickTime movie using your camera and Camera Access 
software. You view and record the live, video images appearing on your 
LCD screen. 

Disable the auto-power-off function when you are recordi ng a video; you 
do not want the camera to turn off during the operations. To disable 
auto-power-off, hold down the action button while turning on the camera. 
Always use the optional power adapter when you disable the auto-power-off 
function. 

IMPORTANT To use the "Video-in" function , your computer must be 

AV-compatible; otherwise, you will not have a digiti zer. 

Attach the QuickTake 200 camera to your computer with the video cable. 

See Chapter 2 for instructions. 

2 Turn on the camera and turn the mode dial to Record-Fine(:::::) or Record{:·:). 

3 Choose "Hide Video-in" from the Window menu to display "Show Video-in." 

The "Video-in" window appears showing live, video images-exactly what 

appears on the camera LCD screen. 
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4 Choose Record from the "Video-in" menu to begin recording. 

Uideo Settings ... 
Uideo Playthru Off During Record 

Full Size 
v' Quarter Si ze 

Record 

5 In the Save dialog box that appears, type the name for your movie in the "New file name" 

box and click Save. 

A screen appears showi ng what you are recording. 

Note: From the Video-in menu , choose Video Playthru Off During Record, so 

that the action stops on your computer screen and you view the recording 
movie on your LCD screen. 

6 To stop recording, press the mouse button. 

A new screen showing your movie appears. 

7 Choose Present Movie from the Movie menu. 

A checkmark appears next to Present Movie. 

8 Click the Run Movie arrow in the lower-left corner of the movie. 

9 Choose Present Movie from the Movie menu to stop the movie and return to the desktop. 

For information about video settings, see your Apple Video Player 
documentation. 

After you save your movie to your hard drive, it appears as a movie icon. 
Double-click the icon to play your movie using Movie Player. 

~ 
Movie 



Using the Camera Access Dispatcher to start other applications 

On your Apple Quick Take 200 Software CD, you received the Picture Works 
NetCard software. You also received a second CD-ROM disc, Adobe Software, 

containing Adobe PageMill and Adobe PhotoDeluxe. You can use these 
products with Camera Access and with Camera Access images. 

Camera Access provides a Dispatcher pane l that lets you load the NetCard 

and Adobe PhotoDeluxe software as well as any other compatible software. 
You can then drag a Camera Access image over the software icon to start 
the application. 

IMPORTANT To use images with Adobe PageMill, first open a PageMill 
document and then drag a Camera Access image onto the page. The image 
appears immediately. 

Install PictureWorks NetCard and Adobe software from the CD-ROM discs that you 

received with your camera. 

2 Make sure that your camera is connected to the computer, and open the Camera 

Access software. 

3 From your computer, open a folder of images. 
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4 From the Window menu, choose Show Dispatcher. 

The Dispatcher panel appears showing no software assigned to it. 

Dispatcher 

Note: You can display the Dispatcher horizontally or vertically by choosing 
Horizontal or Vertical from the Dispatcher menu. 

11EC Dl !~I 

Unusigntd 



5 Click one of the Unassigned icons to display the Open dialog box. 

- Dispatcher 

Click one of the Unassigned icons 
to select it. 

lei Rdobe PhotoOeluHe '" 1.0 ... , = Macintosh 110 

1.;I Adobe PhotoOeluHe'" rn Eje<I 
D Aiier Dork lns tollotion 
D oerornte ( Desklop 

DEHlros 

D Hold Cancel 
D PDE11tros 
D Plug- Ins Open 

The Open dialog box appears. Click Open. 

6 Find and choose Adobe PhotoDeluxe and click Open. 

The Dispatcher panel appears with the Adobe PhotoDeluxe icon in place. 

7 Repeat Steps 5 and 6 for the NetCard application. 

Dlspotcher 

You can also assign other graphics-editing applications. 
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8 Drag an image over the NetCard icon. 

The "Save temp fil e as?" box appears for you to save the fi le in PICT format, 

which is compatible with NetCard and other graphics applications. 

lei Adobe PhotoDelutce'" I .D •I = Mocintosh HD 

'EJ Adobe PliotoDeluur"' 
D Art er Dark lns tallotlon 
D Derorote 
DEHtros 
D 1101d 

Soue t emp file as? 

I Doll 

[ Ej ec t J 

( Desktop J 

( New DJ 

[ Cancel ) 

([ Soue J) 

9 Find the folder where you want to save the image and type a name for the image. 

10 Click Save. 

The NetCard application opens with your image in the center of a card. 

IMPORTANT Only image fil e fo rmats that are compatible wi ll be opened by the 
destination application. For example, NetCard will open PICT and JPEG fil e 
images a nd QuickTime movies. 



Saving an image 

To preserve the changes that you make to an image, you must save the 
modified image. The Save and Save As commands behave as they do in 
other Mac OS- based computer applications. While you are worki ng with an 
image, save your work frequently. 

Whe n you choose the Save As comma nd, you can rename the image and save 
it in the fil e format you want. C lick Save to save your image. 

leii Book I mo9es • I = Macintosh HO 

@ Im age I ~ ( i:.11~ i:t I 
~ Imag e 2 I- ( I ~ lrTidge 3 De sktop 

:&? Im age 4 

~ 
( 

·~. Image 5 
New CJ I 
----

Saue As: ( Cancel I 
~ (I ~ Dolls 

EHIF Sou e 

' ; ,;'JPEG -TIH 

Printing your images 

You can use Camera Access to print your image- while it is on the camera 
or after you transfer it to your computer. You can also print a collection 
of thumbnails. 

Printing a single image 

Open the image that you want to print to full-size. 

This can be an image in the camera or on your computer. 

2 From the File menu, choose Print. 

3 In the dialog box that appears, select the settings that you want. 

Be sure to select Color/Grayscale to print images. 

4 Click Print to send your image to the printer. 
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Printing a collection of images 

Open the Camera Contents window or a folder containing thumbnail images that you 
want to print. 

You cannot select one thumbnai l to print. 

2 From the File menu, choose Print. 

3 In the dialog box that appears, select the settings that you want. 

Be sure to select Color/Grayscale to print images. 

4 Click Print to send your images to the printer. 

Quitting the QuickTake 200 software 

What's next? 
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Choose the Quit command in the File menu to end a session with the 
QuickTake 200 software. If you have made changes to an image but have not 
yet saved them, a message appears asking whether you want to save the image 

before quitting the program. 

See C hapter 4 for important ma intenance and troubleshooting information. 



Maintenance and Troubleshooting 
• • • • • • 

This chapter offers suggestions to help you care for your camera and 
solve problems. 

WARNING If you have a problem with your QuickTake 200 camera and 
nothing presented in this chapter solves it, consult the service and 
support information that came with you Apple product for instructions 
about how to contact an Apple-authori zed service provider or Apple for 
assistance. If you attempt to repair the QuickTake 200 yourself, any 
damage you may cause to the camera will not be covered by the limited 
warranty on your camera. Contact an Apple-authorized dealer or 
service provider for additional information about this or any other 
warranty question. 

Caring for your camera and lens 
T hese suggestions w ill help you mainta in the QuickTake 200 camera: 

• Protect the camera from moisture, steam, and excessive heat. 

• Do not use the camera in very humid , dirty, or dusty areas. 

• Do not use the camera in smoky areas. 
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WARNING Don't expose the camera to sand; this can cause irreparable 
damage. 

• Don't use harsh or abrasive cleaners on the camera. Wipe off dust with a 
clean, dry cloth. 

• To clean the camera lens, Apple recommends that you purchase a camera 
lens cleaning kit from your local photographic supply store. When cleaning, 
don't press hard, or you might scratch the lens. Never wipe a dry lens. 

• Don't scrape the LCD surface or wipe it with an abrasive cloth or 
substance; the surface scratches easily. 

WARNING Don't use solvents or solutions unless they are specifically 
designed for cleaning camera lenses. Don't use chemically treated tissues 
intended for eyeglasses. 

• If you store the camera for an extended period, remove the batteries and 
the storage card (see the next section). When you replace the batteries, 
remember to reset the date and time. (For instructions, see "Setting the 
Date and Time in the Camera" in Chapter 1.) 

Note: You must reset the date and time whenever the batteries are out of the 
camera for more than S minutes. 

• If the camera is taken from a very cold to a very warm area, water drops 
(condensation) might form on the inside of the camera or on the lens. If 
this happens, switch off the camera and wait an hour before usi ng it again. 

Handling the storage card 
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Use only the storage card designed for your camera. These suggestions should 
help you maintain the card: 

• When you are not using your camera or are storing it for long periods, 
remove the card and store it in the plastic sleeve. 

• While you are using the camera, never open the storage card door or 
remove the card; this will turn off the camera and could cause damage to it. 



• Never remove the card while the camera is recording. 

• If condensation forms on the card, remove the card and wait a n hour before 
using it again. 

• Do not bend , drop, or bang the card . 

• Do not use or store the card in very hot, humid, or corrosive environments. 

• Do not touch the card's gold surfaces or allow the surfaces to become 
soiled. Use a dry, lint-free cloth to wipe away a ny soil. 

• Storage cards can be damaged by static electricity during transportation or 
while in storage. Use the static-free case provided or keep the card in a 
storage case, if available. 

WARNING When you format the storage card, al l data is erased, 
including protected images. 

Solving problems 

This section describes some of the problems that you might encounter and 
offers solutions that you can try. 

The camera LCD screen won't go on when you slide the power switch (Q) .... ) 

• T he storage card is not loaded. 

• T he storage card is wri te-protected or is not formatted . 

• The storage card is old and must be replaced. 

• The batteries are not installed correctly. (See "Installing the Batteries" 
in Ch apter l.) 

• T he batteries need to be replaced. 

• You need to reconnect the optional AC power adapter to the camera or 
make sure it is plugged in. 

• The mode dial is not set to Record-Fine (:::::) o r Record (:•:) mode to 
take pictures. 

• The mode dial is not set to one of th e mode icons. Turn the dial until it 
clicks into place. 
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• The camera's memory does not have room for another image. Transfer the 
images from the camera to your computer, then delete the images. (See 
"Deleting Images From the Camera" in Chapter 3.) 

Power goes out during operation 

• You have not used your camera for 2 minutes and auto-power-off turned off 
the camera to save power. Use the power switch to turn on the camera. 

• The batteries need to be replaced. 

• The camera is overheated, and the safety shutoff operated to turn it off. 
Wait a few minutes until the camera has cooled and then switch it on. This 
is a safety device, not a fault. 

The computer doesn't recognize the camera 

Different devices and programs may compete with the camera for the use 
of a serial port on your Mac OS-based computer. If there's a problem, 
a message tells you that the camera is not responding. Make sure the serial 
cable is connected properly, the camera is turned on, and the batteries have 
enough power. 

• If you upgraded your system software after you installed your QuickTake 
camera software, you may need to reinstall the camera software. See "What 
If You Upgrade Your System Software?" in Chapter I. 

• If you are sharing a serial port that you use for another device and 
AppleTalk is turned on, turn off AppleTalk. Apple recommends that you 
always use the modem port. 

• If you tried to install the QuickTake camera software by dragging it to 
your hard disk, it will not work correctly. Reinstall the software using the 
Installer provided on the Apple Quickmke 200 Software CD-ROM disc. 

Not enough memory 

• To make more memory available while running the Apple QuickTake 200 
software, try quitting open programs that you're not using. 



Images are fuzzy, blurry, or blotchy 

• The lens is dirty. Clean the lens. (See "Caring for Your Camera and Lens," 
earlier in this chapter.) 

• The subject or the camera moved. Hold the camera steady. 

• The subject is out of focal range. Check the focus. 

• The image quality setting is not appropriate for the subject. Change to 
Record-Fine(:::::) to preserve details. (See Chapter 2.) 

• The camera is pointed directly at a bright light. Try a different angle. 
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Appendix A 
Technical Specifications 

• • • • • • 

Physical 

• Depth 1.9 in. (47 mm) 

• Width 5.1 in. ( 129 mm) 

• Height 3.0 in . (77 mm) 

• Weight 8.5 oz. (240 g) 

Technical 

• Type Digital Camera 

• Image size 640 x 480 pixels 

• Interface RS-232C 

• Bit depth 24-bit (16 million colors) 

• Memory 2 MB storage card 
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Camera 

• Lens field of view 

• Liquid crystal display 

• ISO 

• Focus range 

• Aperture 

• Shutter speed 

• Input/output ports 

Temperature 

• Operating 

• Storage ( 6 months) 

Power requirements 

• Standby 

• Operating 

Operating environment 

• Temperature 

• Humidity 

Electrical requirements 

• Internal power 

• External power 

Accessories 

• QuickTake 4 MB Storage Card 

• QuickTake 200 AC Adapter 

8 mm (equivalent to 48-mm lens on a 
35-mm film camera) 

1.8 inches color LCD 

equivalent to approximately ISO 100 

Close-up - 3.5 to 5.1 inches (9 to 13 cm) 
Portrait- 17.7 to 35.4 inches (45 to 90 cm) 
Far - 35.4 inches and farther (90 cm 
and farther) 

f2.2 to f8 
l/4 second to 115000 second 

Digital (RS-232C) port 
Video Out port (NTIS required) 

0° to 40° C (32° to 104° F) 

-20° to 60° C (-4 ° to 140° F) 

<500mW 

<4.5W 

0° to 40° C (32° to 104 ° F) 

10 to 85 percent, noncondensing 

4 AA batteries (3.6 V DC to 5.4 V DC) 

4.5 V DC/1.75 A to 8.0 V DC/l.O A 



Appendix B 
Battery Information 

• • • • • • 

The QuickTake 200 camera comes with fou r lithium batteries. In place of the 
lithi um batteries, the camera can also use high-energy alkaline batteries and 
NiCad rechargeable batteries. This appe ndix contains important information 
about the batteries you can use in the QuickTake 200 camera. 

Caring for batteries 

Here are some general suggestions for good batte ry care. 

• Do not mix d ifferent types of batteries. 

• Always handle batteries carefully. 

• When inserting batteries, check the polarity markings on the battery 
(+and - ) to ensure that you insert them correctly. Incorrect battery polarity 
may cause batteri es to split or leak, which could resul t in a fire, injury, or 
damage to the camera. 

• Do not atte mpt to charge lithium or alka line batteri es. Doing so may cause 
the batteries to split or leak. 

• Du nut short-circ uit battery terminals (that is, do not touch both terminals 
w ith a metal object). Do not carry loose batteries in a pocket or purse 
where they may mix with coins, keys, o r other metal objects. Doing so may 
cause an explosion or a fire. 

• Do not drop, puncture, disassemble, mutilate, immerse in water, or 
inci nerate the batteries. 

• Intense heat can shorten battery li fe. Do not leave batteries in hot locations 
(such as the trunk of a car) for more than a day or two. 
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lithium 
(LI) 

• Remove the batteries when the camera will not be used for an extended 
period of time. If the batteries leak, clean and wipe the battery 
compartment carefully. Wash your hands carefully if you touch the 
battery fluid. 

• Store unused batteries in a dry place at normal room temperature. 

IMPORTANT Batteries contain chemicals, some of which may be harmful to 
the environment. Please dispose of used batteries according to your local 
environmental guidelines. 

Ways to improve battery performance 
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Here are some tips that may help you get the most from your batteries. 

• For longest battery li fe, use lithium batteries. 

• When you replace used batteries, replace all the old ones with new ones. 
Mixing new and used batteries weakens the performance of the new ones. 

• Batteries work best when the contact surfaces are clean. If necessary, 
clean these surfaces by gently rubbi ng with a clean pencil eraser or a cloth. 

WARNING When you use the camera in hot conditions, a safety 

feature operates that switches off the camera as a protective 
measure. Wait until the camera cools down and then switch it on. 



Appendix C 
About ColorSync 

• • • • • • 

Mac OS-based computers use ColorSync to help make sure that the colors 
you see on your monitor closely match the colors you get on your printers, 
scanners, and other devices. Because ColorSync works behind the scenes, 

you don' t have to know anything about it. All you need to do is initia lly set it 
up. Th is appendix describes how ColorSync works and how to configure your 
monitor and computer to take advantage of it. 

The problem that ColorSync solves 

Providing consistent color with desktop compute rs is a technical challenge 
because di fferent color devices use different methods for representing color, 

and they produce different ranges of colors. For example, the colored light on 
your monitor is very different from the colored inks your printer uses. 

Different color devices also create color using differen t methods. Monitors 
(and most scanners) produce colors by mi xing red, green, and blue light­
called RGB color.· Most printers produce colors by mixing cyan (a shade of 
blue), magenta (a bright pink), yellow, and black ink. This color system is 
called CMYK Since monitors, printers, and scanners each have different color 
capabili ties, they cannot reproduce each other's colors exactly. 

) 
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Further compounding the problem is that no two monitors or printers produce 

exactly the same colors. (For example, you can see differences in color ability 
among monitors in the TV department of a consumer electronics store.) 

ColorSync is a system extension that provides color-conversion capabilities and 
improves color consistency. ColorSync " translates" the colors used on one 
device so that they more closely match the colors displayed or printed on 
another device. 

ColorSync color conversion is a central part of Mac OS-based computing, 
ensuring that applications, monitors, printers, scanners, and digital cameras can 
use the same scheme for color conversion. This means you can scan an image, 
display it on your monitor, and print it-with visually matching colors every 
step of the way. 

How ColorSync works 
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When you create a TIFF or PICT fil e using a program that supports ColorSync, 

a "profi le" describing the color capabilities of your equipment is saved with the 
image. For example, whe n you scan a photograph, a profile describing the 
scanner is saved inside the image file. If you later pri nt the image, even using a 
different computer, ColorSync looks at the profile to learn about the 
capabilities of the scanner you used, and automatical ly picks closely matching 
colors that your printer can reproduce. 

The profile conta ins info rmation ColorSync needs to perform color matching, 
such as the lightest and darkest possible tones (white point and black point) 
that the device can produce, and the max imum supported densities for red, 
green, blue, cyan, magenta, and yellow. Together, these characteristics describe 
the color gamut (or range) that a device is capable of capturing, d isplaying, or 
reproducing. To take advantage of ColorSync, each of the imag ing devices you 
use needs to have its own ColorSy nc profi le. When you create images using 
these devices, information from the profile wi ll automatical ly become part of 
the image fi le- ensuring that colors are consistent throughout the enti re 
creative process. 



Because ColorSync information becomes part of your output files, you don't 
have to worry about losing the profile or using the wrong profile w ith the 

wrong image. Additionally, ColorSync profiles are in the standard 
Internationa l Color Consortium (ICC) format recognized by M icrosoft 
Windows, Mac OS, and other systems. 

When you work with an image that has an embedded ColorSync or ICC 
profi le, ColorSync identifies the colors that your monitor or printer can 
reproduce by examining their ColorSync profile. It compares their capabilities 
w ith those of the system used to create the image (as described in the 
embedded profi le), and then picks appropriate, matching colors. For example, 
your monitor may be able to display a vivid red, but your printer inks may not 
be able to produce that color. ColorSync determines the "next best" color for 
your printer to use. 

Monitor Printers 

O __ '._.--· ....... l;l ..,. ColorSync profile 

.... ~ 

""· ·blr 
.. ~ ""· 

·· .. ~ 

~ 
ColorSync 

Digital cameras Scanners 

ColorSync performs color match ing by comparing each profi le to an 
independent color standard. ColorSync uses the CIE color standard, which 
describes colors in terms of how they are perceived by the human eye under 
specific lighting condition s. (CIE stands for the Commission International de 
l 'Eclairage, the International Commission on Illumination, which created the 
standard in 1931.) 
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Setting up ColorSync 
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To take advantage of ColorSync, you need to obtain profiles for each of your 
imaging devices, such as your monitor, scanner, and color printer. ColorSync 
profiles are usually automatically installed when you install the software for a 
ColorSync-supported device. Profiles are stored in the ColorSync Profiles 
folder, inside Preferences in the System Folder. If you need to obtain a 
ColorSync profile, contact the manufacturer of your device. Ask for either a 
ColorSync or ICC profile for the specific model of monitor, printer, or 
scanner you're using. 

You also need to make sure the ColorSync extension is installed and active. 
ColorSync is automatically installed in the Extensions folder of your System 
Folder during Apple Vision software installation. Unless you've removed or 
disabled it, it's already installed. 

Finally, you need to set a ColorSync System Profile for the Mac OS. The 
ColorSync System Profile is used by ColorSync to determine the color range 
of your monitor. ColorSync compares this information with the profiles of 
your other devices to make sure that colors are consistent with what you see 
on your monitor. 

Additionally, the System Profile is used as a default profile if a document you 
are working on doesn't have any ColorSync information saved within it. This 
can occur if the document was created without ColorSync installed. By using 
the System Profile as a default, ColorSync ensures that colors are consistent 
with what you currently see on your monitor. 



Setting the ColorSync System Profile 

To set the System Profile, follow these steps: 

Make sure the profile you want to use is located in the ColorSync Profiles folder. 

This folder is located in the Preferences folder in your System Folder. 

2 Choose Control Panels from the Apple (ti) menu and open the ColorSync System Profile 
control panel. 

The ColorSync System Profile control panel appears. 

l~F-1-"- ColOrSJLOC'~ ;___ 

~ 21 [ Set Pro file ... J 

App1'Ylston eso - 9300 

3 Click Set Profile. 

A dialog box appears with a list of ColorSync profiles installed on 
your computer. 

4 Click the profile you want to use or create your own custom profile. 

Select New Syst em Pro file: 

lesi ColorSync"' Profiles ,.. I = Macintosh HD 

[!) Apple Multiple Scan 20 - 065 ~ 
[!) Apple Performa Di splay 
[!) Apple Performa Plus Display 
[!) AppleUlslon 171 O - 9300 

11ii " . ~ 11 

[ii Mac Color Classi c Stan el6 re1 
[ii Mac Color Display St anelarel • 

App leUlslon 850 - 9300 
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[ Desktop ) 
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Select the profi le for your monitor. (If you don't have a profi le, contact the 
monitor manufacturer.) 
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5 Click Select. 

ColorSync automatically references the profile you selected and uses it to 
defin e the color capabili ties of your monitor. 

6 Close the ColorSync System Profile control panel. 

Setting other ColorSync profiles 

Some programs and printer software might require that you do someth ing 
special, such as turning on an option, in o rder to take advantage of ColorSync. 
For example, to use ColorSync with th e Apple Color OneScanner, select the 

Use ColorSync option in the ColorSync Preferences dialog box of the 
OneScanner Dispatcher software. This te ll s the scanning software to embed 

information about the Color OneScann er in scann ed images. 

Refer to the instructions that came with your application or device to 
determine if it supports similar options. If there's an option to specify a 
profile or to activate ColorSync, be sure to use it. 

Tips for best results 
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After you've made sure ColorSync is installed , set the System Profile, and set 

any necessary ColorSync options for your applications, you're ready to begin 
taking advantage of ColorSync! Just scan, create, a nd print your images or 
documents as you normally would. ColorSync works beh ind the scenes to 
ensure consistent color matching. 

The following settings and strategies will help you get the best color results 

from your system. Not all of these ti ps will apply to the software and devices 
you may be using, but be sure to take advantage of those tips that do. 

• Set the gamma curve for your monitor to " l.8:Standard" to have the 
monitor more closely match printed results. 

• When printing in color, check to see if the prin ting options include a 
setting for ColorSync. For example, for the Apple LaserWri ter 12/600 PS, 
turn on ColorSync by clicking the Options button and selecting ColorSync 
Color Matching. 



• l f your scanning program has a ColorSync option, use it. This embeds a 

ColorSync profi le within the scanned image fi le, and ColorSync will be 
better able to reproduce the o riginal colors on your monitor and printer. 

• Don't try to use two color-match ing systems at once on your computer. 
Some applications install other color-matchi ng systems. These should 

either be removed or disabled if you want to use ColorSync. 

For more information 

To learn more about ColorSync, or color matching and color technology in 
general, refer to these publications and resources. 

Publications 

Advanced Color Imaging on the Mac OS, Apple Computer, Inc., 
Addison-Wesley Developers Press, ISBN 0-201-48949-X 

ColorSync 2.0 White Paper at gopher://info.apple.com 

Internet resources 

Apple Imaging Web Site at http://imaging.apple.com 

Apple Technical Information Library at http://til.i nfo.apple.com 

International Color Consortium at http://www.color.org 

ColorSync plug-ins for use with Adobe Photoshop (Macintosh Uti lities 
section of the Apple Software Updates page on the Apple Support and 
Information Web at http://www. info.apple.com) 
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Appendix D Transferring DOS Images 
to Mac OS-Based Portable Computers 

• • • • • • 

If you use a Mac OS- based portable computer with a PCMCIA slot and have 
an optional PC card adapter, you can transfer DOS images from your storage 
card to your portable computer using Macintosh PC Exchange. You assign 
Camera Access to the DOS . JPG suffix so that DOS files with that suffix are 
compatible with your Mac OS-based computer. You can store images on your 
computer, and you can work with the image files using the Camera Access 
software. 

IMPORTANT Always transfer all images to your computer before working with 
them. Do not work with images that remain on the storage card . After you 
edit an image file on your hard drive, you can move it back to your camera 
using the Upload function. 

Open the PC Exchange control panel on your Mac OS-based portable computer. 

2 In the PC Exchange dialog box that appears, click Add. 

3 In the DOS Suffix box, type . JPG. 

4 In the scrollable list, select Camera Access as the specified application program. 

5 Select JPEG from the Document Type pop-up menu. 
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6 Click OK. 

The fi rst PC Exchange dialog box reappears with the JPEG fi le type assigned 
to Camera Access. This maps DOS fil es with the . JPG suffix to the JPEG 

fi le type of the Camera Access application. 

You can open and view DOS . JPG fi les in Camera Access, and you can save 
fi les in other formats (EXIF, PICT, and T IFF). 

7 Place your storage card in the PC card adapter. 

8 Insert the PC card adapter into one of the PCMCIA card slots on your portable computer. 

You can now open and work with the storage card images from your camera. 
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A 

accessories 68 
AC power adapter. See power adapter 
action button 

Auto Play mode and 23 
auto-power-off function and 27 
battery-saving mode and 26 
Erase mode and 24, 25 
location of 3 
Protect mode and 25 
Record mode and J 9 
Self-Timer mode and 21 

Adobe PageMill software 55 
Adobe PhotoDeluxe software 55 
alkali ne batteries 69 
apertu re 17, 68 
aperture selector 3, 17 
Apple menu 75 
Apple QuickTake 200 folder 5 
Apple QuickTake 200 Software CD-ROM 

disc 5 
AppleTalk 3 1, 64 
appl icatio ns 

Adobe PageMill 55 
Adobe PhotoDeluxe 55 
PictureWorks Netcard 55 

QuickTake Camera Access 5, 33- 34, 
48-54 

scanning appl ications 77 
starting applications with Camera 

Access Dispatcher 55- 58 
Auto-Play mode 4, J 5, 23 
auto-power-off 27, 53, 64 

B 

batteries 
alkaline 69 
caring for 69-70 
cleaning contact surfaces of 70 
conserving 22, 26, 28, 35, 38 
disposing of 7, 70 
improving performance of 70 
install ing 6-7, 69 
leaking 70 
life of 70 
lithium 69, 70 
polarity of 69 
rechargeable 28 
replacing 7 , 70 
storing 70 
troubleshooting 63 

81 
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balle ry door 
location of 3 
opening 6 

batte ry door re lease button 3 
batle ry-saving mode 26 
bit depth 67 
blotchy images 64-65 
blurry images 64-65 
brightness 

o f images 44--45 
o f LCD screen 17 

brightness dial I 7 

c 
cables 

serial cable 3 1, 32 
turn o ff computer before 

connecting 32 
video cable 22 

Camera Access application 33-60 
commands in. See commands 
connecting to the camera with 33-34 
gelling information about images 

with 36 
making videos and movies with 

48- 54 
menus in. See menus 
moving images between Camera 

Contents and Viewer folder with 
4 1-43 

naming images with 39 
opening images to fu ll size with 

36-37 
tasks performed by 33 
transferring images to computer 

wi th 38 
uploading images from computer to 

camera with 39-40 
using to work with images 44--48 
viewing images with 35, 4 1-43 

Camera Access Dispatcher, starting other 
applications with 55- 58 

Camera Access icon 33, 38 
Camera Contents window 

moving images between Camera 
Contents and Viewer folder 
4 1-43 

purpose of 35 
selecting images in 36 

camera mode dial 4, 19-26. 
See also modes 

caring for the camera and lens 61-62 
carry ing strap, attaching 10 
carrying strap mount, location of 3 
CIE colo r standard 73 
cleaning 

battery contact surfaces 70 
camera and lens 62 
seal on storage card 9 
storage card 62 

close-up focal setting 16, 18 
CMYK color 7 1 
color matching . See ColorSync 
color printing 76 
color range 72-73 
ColorSync 7 1-77 

how ColorSync works 72- 73 
obtaining further information 

about 77 
problems solved by 7 1 
resources for 77 
tips for best results with 76-77 

ColorSync extension 74 
ColorSync System Profile 72-76 
ColorSync System Profi le control panel 

(Apple menu) 75 
commands 

Copy All Images to Disk (V iewer 
menu) 38 

Copy Selected Images to Disk 
(Viewer menu) 38 

Get Info (File menu) 36 
H ide Video-in (Window menu) 53 
Horizontal (Dispatcher menu) 56 
Loop (Movie menu) 52 



Loop Back and Forth (Movie 
menu) 52 

Open Folder Viewer (File menu) 42, 50 
Present Movie (Movie menu) 50, 5 1, 

52,54 
Print (Fi le menu) 60 
Quit (File menu) 60 
Recompress Movie (Movie menu) 52 
Record (Video-In menu) 54 
Size (Movie menu) 52 
Undo (Edit menu) 47 
Upload Image (QuickTake 200 

menu) 39 
Vertical (Dispatcher menu) 56 
Video Playthru Off During Record 

(Video-in menu) 54 
Zoom In and Zoom Out (Image 

menu) 37 
communications regulation 

information vi 
Computer mode 4, 23-24 
condensation 

on camera or lens 62 
on storage card 63 

connecting 
cables, safety precaution for 32 
camera to computer 3 1-32 
to camera with Camera Access 

application 33-34 
conserving power 35, 38 
contrast of images 44-45 
control panels 

ColorSync System Profile control 
panel 75 

PC Exchange control panel on Mac 
OS-based portable computer 79 

Copy All Images to Disk command 
(Viewer menu) 38 

Copy Selected Images to Disk command 
(Viewer menu) 38 

cropping images 46 
crosshair cursor 46 

D 

date and time 
displaying and hiding 12 
resetting 62 
setting 11- 12 

DC IN 6V socket 28 
delayed photographs 20 
deleting images 

with Erase mode 24-25 
with Viewer menu commands 43 

depth specifications 67 
Digital port on camera 32 
Dispatcher menu, Horizontal or Vertical 

command 56 
Dispatcher panel 55-57 
displaying and hiding date and time 12 
disposing of batteries 70 
DOS images, transferring to Mac 

OS-based portable computers 
79-80 

dragging and dropping images between 
folders 4 1 

E 

editing images on your computer 44-48 
Edit menu, Undo command 47 
electrical requirements 68 
electrical shock, avoiding 28 
enlarging images 37 
Erase mode 

formalling storage card with 9 
frame numbers d isplayed in 15 
purpose of 4 
working with 24-25 

erasing images 
with Erase mode 24-25 
with Viewer menu commands 43 

erasure, guarding against 25-26 
exposure warning 17, 18 
external power specifications 68 

Index 83 
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F 

Far focal setting L6 
FCC statement vi 
file formats 

JPEG 40, 58, 79, 80 
PICT 40, 58, 72 
TTFF 72 

File menu 
Get Info command 36 
Open Folder Viewer command 42, 50 
Print command 60 
Quit command 60 

files 
JPEG files 40, 79, 80 
PICT files 40, 72 
renaming 39 
saving 39 
TIFF files 72 

Finder, renaming fi les with 39 
flipping images 47 
fluorescent li ohtino 17 0 0 

focal distance, estimating 16 
focal range specifications 68 
focus 

close-up focus 18 
setting 16 

focus selector 3, J 6 
folders 

Apple QuickTake 200 folder 5 
dragging and dropping images 

between 4 1 
selecting 42 
Viewer folder 4 1-43 
viewing thumbnai ls of images in 41 

formats. See file formats 
formatting the storage card 4, 9, 24-25 
frame numbers 15 
frames 

playing back 23 
scrolling through 2 1 
selecting seconds between 23 

framing the subject 14 
fuzzy images 64-65 

G 

gamma curve for monitor, setting 76 
Get In fo command (File menu) 36 

H 

heat, problems caused by 64, 70 
height specifications 67 
Hide Video-in command (Window 

menu) 53 
hiding and displaying date and time 12 
Horizontal command (Dispatcher 

menu) 56 
humidity 68 

ICC profile 74 
icons 

Camera Access icon 38 
movie icon 51, 54 
protection icon 25 
Unassigned icons 57 

Image menu, Zoom In and Zoom Out 
commands 37 

images. See also movies or specific topic 
blotchy 64-65 
blurry 64-65 
brightness of 44-45 
close-up 16 
contrast of 44-45 
c ropping 46 
deleting from camera 43 
DOS 79-78 
dragging and dropping between 

folders 4 1 
ed iting on computer 44-48 
enlarging 37 
erasing from storage card 4 
flipping 47 
fuzzy 64-65 
getting information about 36 



indoor pictures 17 
lightness of 45--48 
moving between Camera Contents and 

Viewer folder 41--43 
naming 39 
number of images in camera 34 
opening more than one 36 
opening on computer 44--48 
opening to fu ll size 36-37 
picture quality, setting modes for 4 
printing 59-60 
printing thumbnails of 59 
QuickTime movies 53- 54 
reducing 37 
renaming 39 
rotating 48 
saving 59 
sharpness of 45--48 
taking pictures 13-29 
transferring DOS images to Mac 

OS- based portables 79-80 
transferring from camera to computer 

4,23-24,38 
transferring from computer to camera 

34,39--40 
viewing by date 43 
viewing by name 43 
viewing in camera 2 1- 23, 35 
viewing multiple images 23 
viewing on computer 41--43 
viewing on LCD screen 21 -23 
viewing on television 2 1-23 
viewing thumbnai ls of 41--43 
working with 44--48 
write-protecting 25-26 

image size specifications 67 
indoor pictures 17 
Industry Canada statement vii 
input/output ports on camera 68 
installing 

batteries 6- 7 
optical viewfinder 18-19 
QuickTake camera software 5, 64 
storage card 7-9 

interface specifications 67 
interference on radio and television vi 
internal power specifications 68 
Internet resources for ColorSync 77 
ISO specification s 68 

J, K 

JPEG file format 40, 58, 79, 80 

L 

LCD b1ightness dial, location of 3 
LCD screen 

brightness of 3, 17 
location of 3 
putting to sleep 26 
turning off 19 
turning on 19, 26 
viewing images on 21-23, 35 
viewing movies on 54 

LCD specifications 68 
lens 

caring for 6 1-62 
field of view 68 
location of 3 
moisture o n 62 

light 
adjusting 45-48 
red sleep light 19 

lighting, fluorescent 17 
lightness of images 45--48 
light setting 17 
lithium batteries 69, 70 
looking at images. See viewino imaoes 
Loop Back and Forth comman"d (M~vie 

menu) 52 
Loop command (Movie menu) 52 

Index 85 
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/ 

M 

Macintosh PC Exchange 79 
Mac OS-based computers, using the 

camera with 3 1-60 
Mac OS-based portable computers, 

transferring DOS images to 
79-80 

maintenance 61-63 
memory, insufficient amount of 64 
menus 

Apple menu 75 
Dispatcher menu 56 
Edit menu 47 
File menu 36, 60 
Movie menu 50, 51, 54 
QuickTake 200 menu 39 
Video-in menu 54 
Viewer menu 43 

mode dial 
location of 3 
troubleshooting 63 

modem port on computer 23, 31, 32, 64 
modes 

Auto-Play mode 4, 15, 23 
battery-saving mode 26 
Computer mode 4, 23-24 
Erase mode 4, 9, 15, 24-25 
Play mode 4, 15, 21- 23 
Protect mode 4, 15, 25- 26 
Record-Fine mode 4, 11 , 14, 19-20 
Record mode 4, 14, 19-20 
selecting 4 
Self-Timer mode 4, 21 

moisture 
on camera or lens 62 
on storage card 63 

monitor 
ColorSync profile for 75 
gamma curve 76 

movie icon 51, 54 

Movie menu 
Loop Back and Forth command 52 
Loop command 52 
Size command 52 
Present Movie command 50, 52, 54 
Recompress Movie command 52 

Movie Player 54 
movies. See also images 

looping 52 
naming 49 
playing 54 
QuickTime movies 53-54 
recompressing 52 
recording 48-54 
running 52 
stopping action of 54 
viewing on LCD screen 54 

moving images 

N 

between Camera Contents window 
and Viewer folder 41-43 

from computer to camera 34 

naming 
images 39 
movies 49 

number of images in the camera 34 

0 

Open Folder Viewer command (File 
menu) 42, 50 

opening 
battery door 6 
images on your computer 44-48 
images to full size 36 
more than one image 36 
storage card door 8 

operating environment 68 
operating power 68 
operating temperature 68 
optical viewfinder. See viewfinder 
overexposure warning 17, 18 
overheated camera 64, 70 



p 

PC card adapter 79 
PC Exchange control panel on Mac 

OS- based portable computer 79 
PCMCIA slot on Mac OS- based 

portable 79 
photographs. See images or specific topic 
physical specifications 67 
PICT file format 40, 58, 72 
picture quali ty, setting modes for 4 
pictures. See images; movies; taking 

pictures or specific topic 
PictureWorks NetCard software 55 
pixels 19, 20 
playing back consecutive frames 4 
playing movies 54 
Play mode 4, 15, 21 -23 
portable computers 

PCMCIA slot on 79 
transferring DOS images to Mac 

OS-based portables 79- 80 
Portrait focal setting 16 
ports 

Digital port on camera 32 
input/output ports on camera 68 
modem port on computer 23, 3 1, 

32, 64 
printer port on computer 3 1, 32 
serial port on computer 32, 64 
video input port on television 22 
Video Out port on camera 22 

power 
conserving 22, 26, 28, 35, 38 
improving batte ry performance 70 
troubleshooting 64 

power adapter 27, 28, 3 1,35 
power-off function 27 
power requirements 68 
power specifications 68 
power switch 3, 13 
Present Movie command (Movie menu) 

50, 5 1,52,54 
Print command (File menu) 60 
printer port on computer 23, 3 1, 32 

printing 
images 59-60 
in color 76 
thumbnails of images 59 

problems. See troubleshooting 
protection icon 25. See also 

write protection 
Protect mode 4, 15, 25- 26 

a 
QuickTake 200 AC Power Adapter. See 

power adapter 
QuickTake 200 Camera Access 

application. See Camera 
Access application 

QuickTake 200 panel 34, 35 
QuickTake 200 software 

installing 5 
quitting 60 

QuickTime IC movie panel 50 
QuickTime movies, creating 53-54 
Qui t command (File menu) 60 
quitting, QuickTake 200 software 60 

R 

radio and television interference v1 
rechargeable batteries 28 
Recompress movie command (Movie 

menu) 52 
Record command (Video-in menu) 54 
Record-Fine mode 4, 11 , 14, 19-20 
recording movies and videos 48-54 
Record mode 4, 14, 19-20 
red sleep light 19 
reducing images 37 
renaming images 39 
repair 61 
replacing batteries 7, 70 
resetting date and time 62 
resolution 19, 20 
RGB color 71 
rotating images 48 
Run Movie arrow 51 , 54 

Index 87 



88 Index 

s 
safety precautions 

batteries 6, 69-70 
caring for the camera and lens 61-62 
disposing of balleries 7 
handling the storage card 62-63 
Important Safety Instructions vii-viii 
power adapter 28 

saving 
files in PICT formal 58 
images 59 

Scale pop-up menu 37 
scanning programs, ColorSync option 

in 77 
screen 

brightness of 17 
changing size of 52 

scrolling through frames 21 
selecting a folder 42 
Self-Timer mode 4, 2 1 
serial cable 3 I, 32 
serial port on computer 32, 64 
service 6 1 
setting date and time I 1- 12 
sharpness, adjusting 45-48 
shutter 19 
shutter re lease 3, 15, 26 
shutter speed 68 
Size command (Movie menu) 52 
sleep 26 
sleep light 19, 26 
slide shows. See movies 
software. See applications; Camera 

Access application; 
system software 

software license agreement 5 
specifications 67- 68 
standby power 68 
starting other appl ications with Camera 

Access Dispatcher 55- 58 
static electricity, s torage card and 63 

storage card 
cleaning 63 
cleaning seal on 9 
erasing frames on 24-25 
erasing images from 4 
formatti ng 4, 9, 24-25 
handling 62- 63 
installing 7- 9 
moisture on 63 
removing before storing camera 8 
static e lectricity and 63 
storing 63 
transferring DOS images from storage 

card to portable computer 79 
troubleshooting 63 
write-protecting 9 

storage card door 3, 8, 20, 62 
storage card slot 3 
storage temperature 68 
storing 

batteries 70 
camera 8, 62 
storage card 63 

strap, attaching I 0 
strap mount, location of 3 
sunlight, distortion from 18 
support 6 1 
system requirements 2 
system software, upgrading 12, 64 

T 

taking pictures 13- 29. See also images 
or specific topic 

framing the subject 14 
setting aperture 17 
setti ng focus 16 
steps for 14-15 
turning on the camera 13-14 
using AC power adapter 27-28 
using auto-power-off function 27 
using battery-saving mode 26 
using camera mode dial 19-26 
using optical viewfinder 18-19 

-



technical specificat ions 67-68 
television 

interference on vi 
playing back consecutive frames 

on 23 
video input port on 22 
viewing images o n 2 1- 23 

thumbnail images 
printing 59 
viewing on your computer 4 1-43 

TlFF fi le format 72 
time 

displaying and hid ing 12 
resetting 62 
setting 11 - 12 

timer 20- 21 
timer/sleep light, location of 3 
transferring 

DOS images lo Mac OS- based 
portables 79- 80 

images between Camera Contents 
window and Viewer folder 
4 1-43 

images from camera to computer 
4 , 23-24,38 

images from computer to camera 
39-40 

transit temperature 68 
tripod mount, locatio n of 3 
troubleshooting 63-65 

batteries 63 
co mputer does not recognize 

camera 64 
images are fuzzy, blurry, or blotchy 

64-65 
LCD screen won' t go on when you 

slide the power switch 63 
leaking batteries 70 
memory 64 
mode dial 63 
overheated camera 64, 70 
power goes out during operation 64 
storage card 63 

turning off the camera 14 
safety shutoff when camera overheats 

64, 70 
turning on the camera 13-14 
turning on the LCD screen 26 

u 
Unassigned icons 57 
underexposure warning 17, 18 
Undo command (Edit menu) 47 
upgrading system software 12, 64 
Upload button (QuickTake 200 panel) 

34,35 
Upload Image command (QuickTake 200 

menu) 39 
uploading images from computer to 

camera 39-40 

v 
VCCI Class 2 statement vii 
Vertical command (Dispatcher menu) 56 
video cable 22 
Video-in fu nction 3, 53 
Video-in menu 

Record command 54 
Video Playthru Off During Record 

command 54 
Video Out port on camera 22 
Video Playthru Off During Record 

command (Video-i n menu) 54 
videos, recording 48-54 

creating a movie with images stored 
o n your computer 48- 52 

creating a QuickTime movie 53- 54 
Viewer button, (QuickTake 200 panel) 

34,35 
Viewer folder, moving images between 

Camera Contents window and 
4 1-43 
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Viewer menu 
Copy All Images to Disk 

command 38 
Copy Selected Images LO Disk 

command 38 
viewfinder 16, 18- 19, 26 
viewing 

images by date 43 
images by name 43 
images in camera 35 
images on LCD screen 2 1- 23 
movies on LCD screen 54 
multiple images 4, 23 
single images 4 
thumbnails images on computer 

4 1-43 

w,x, y 
weight specifications 67 
width specifications 67 
write-protection 

z 

of images 25-26 
of storage card 9 

Zoom In and Zoom Out commands 
(Image menu) 37 
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